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Abstract

These Application Notes describes the steps to configure Session Initiation Protocol (SIP)
Trunking between Voice Carrier and an enterprise solution using Avaya IP Office Release 8.1
and Avaya Session Border Controller for Enterprise 6.2.

The Voice Carrier IntelliSIP Trunking Service provides PSTN access via a SIP trunk between
the enterprise and the Voice Carrier network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise. Voice Carrier is a
member of the Avaya DevConnect Service Provider program.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describes the steps to configure Session Initiation Protocol (SIP)
Trunking between Voice Carrier and an enterprise solution using Avaya IP Office Release 8.1
and Avaya Session Border Controller for Enterprise 6.2.

The Voice Carrier IntelliSIP Trunking Service referenced within these Application Notes is
positioned for customers that have an IP-PBX or IP-based network equipment with SIP
functionality, but need a form of IP transport and local services to complete their solution.

The Voice Carrier IntelliSIP Trunking Service will enable delivery of origination and
termination of local, long-distance and toll-free traffic across a single broadband connection.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

The general test approach was to connect a simulated enterprise site to the Voice Carrier
IntelliSIP Trunking Service via the public Internet and exercise the features and functionality
listed in Section 2.1. The simulated enterprise site was comprised of Avaya IP Office, Avaya
Session Border Controller for Enterprise (Avaya SBCE) and various Avaya endpoints.

The Voice Carrier IntelliSIP Trunking Service passed compliance testing with the observations
or limitations described in Section 2.2.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Use of UDP or TCP for the transport layer to the service provider

¢ Sending and receiving SIP OPTIONS queries to the service provider

¢ Incoming PSTN calls to SIP and H.323 telephones at the enterprise. All inbound PSTN
calls were routed to the enterprise across the SIP trunk from the service provider.

¢ Qutgoing PSTN calls from SIP and H.323 at the enterprise. All outgoing PSTN calls
were routed from the enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound PSTN calls to/from soft clients. Avaya IP Office Video
Softphone and Avaya Flare® Experience for Windows were tested.

e Various call types including: local, long distance, outbound toll-free, international and
local directory assistance.

® Codec G.711MU
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Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Voicemail navigation using DTMF for inbound and outbound calls.
User features such as hold and resume, transfer, and conference.
Off-net call forwarding and twinning

G.711 pass-through fax

REFER message for network call redirection

Inbound toll-free calls and 911 emergency calls are supported but were not tested as part of
the compliance test.

The following items are not supported:

G.729 codec
Operator (dial 0) and operator-assisted ( dial 0 + 10 digits) services
T.38 Fax

2.2. Test Results

Interoperability testing of the Voice Carrier IntelliSIP Trunking Service was completed with
successful results for all test cases with the exception of the observations/limitations described

below.

Codec not locked down on outbound calls: On outbound calls, Voice Carrier responds
to the INVITE request with multiple codecs, instead of selecting one from the INVITE
SDP list. IP Office uses the first compatible codec in the list. This behavior has no user
impact. Calls were successful.

Inconsistent SIP headers on inbound Calling Party Number blocked calls: On
inbound Calling Party Number (CPN) blocked calls, Voice Carrier sends a SIP INVITE
message containing two headers which contradict each other. The INVITE contains the
Privacy = none header which indicates that the calling party number should not be
blocked. The INVITE also contains the Remote-Party-ID header with parameter
privacy=full which indicates that the calling party number should be blocked. In this
scenario, IP Office blocked the calling party number as intended. The call was
successful.

Blind transfer with Avaya 1100 IP Deskphones calling party number: An Avaya
1100 Series IP Deskphone (SIP) places an outbound call to the PSTN, then performs a
blind transfer of this call to another PSTN endpoint. In this scenario, the wrong calling
party number is displayed on the second PSTN endpoint. The display shows the number
dialed by the Avaya 1100 Series IP Deskphone for the initial outbound call including the
short code (9) + 1 + 10 digits. The behavior is expected to be the same as with IP Office
H.323 endpoints which is to display the transferring party number. This is an IP Office
issue and is under investigation by the IP Office development team.
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2.3. Support

For technical support on the Voice Carrier IntelliSIP Trunking Service, contact Voice Carrier
using the Support links at www.voicecarrier.com or by calling 1-888-830-6230.

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Voice Carrier IntelliSIP Trunking
Service.

Located at the edge of the enterprise is the Avaya SBCE. It has a public side that connects to the
external network and a private side that connects to the enterprise network. All SIP and RTP
traffic entering or leaving the enterprise flows through the Avaya SBCE. In this way, the Avaya
SBCE can protect the enterprise against any SIP-based attacks. The Avaya SBCE provides
network address translation at both the IP and SIP layers.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
2003 Server running both Avaya IP Office Manager to configure the Avaya IP Office and Avaya
Preferred Edition for voicemail (also known as VoiceMail Pro).
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Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to Voice Carrier. The short code of 9 and any preceding 1 is stripped off by
Avaya IP Office and the remaining 10 digits were sent unaltered to Voice Carrier. For outbound
calls, Avaya IP Office sent 10 digits in all headers. For inbound calls, the Voice Carrier
IntelliSIP Trunking Service sent 10 digits in the Request URI and the To field of inbound SIP
INVITE messages.
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment Software
Avaya IP Office 500 v2 8.1 (69)
Avaya IP Office Manager 10.1 (69)
Avaya IP Office Preferred Edition 8.1 (9203)
(Voicemail)
Avaya Session Border Controller for 6.2.0.Q36

Enterprise running on a Portwell CAD-0208
server

Avaya 1140E IP Deskphone (SIP)

4.3 SP1 (04.03.12.00)

Avaya 1608 IP Deskphone (H.323) running
Avaya one-X® Deskphone Value Edition

1.3 SP3 (1.3.3)

Avaya 9641G IP Deskphone (H.323) running
Avaya one-X® Deskphone Edition

6.2 SP2 (6.2209)

Avaya IP Office Video Softphone (SIP)

3.2.3.48 (67009)

Avaya Flare® Experience for Windows 1.1.2.11
Voice Carrier Components
Equipment Software
IntelliSIP 2.1 -avl.6.2.18

Testing was performed with IP Office 500 V2 R8.1, but this testing also applies to IP Office
Server Edition R8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 V2
R8.1 to support analog or digital endpoints or trunks. Also, IP Office 500 V2 does not support
SIP Direct Media so Server Edition SIP Direct Media functionality was not compliance tested.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office > Manager to launch the
application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Open Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP
Office configuration. All licensing and feature configuration that is not directly related to the
interface with the service provider (such as twinning and IP Office Video Softphone support) is
assumed to already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License =
SIP Trunk Channels in the Navigation pane. Confirm a valid license with sufficient Instances
(trunk channels) in the Details pane.

IP Offices =) SIP Trunk Channels e -

R BOOTP (4) #| | Licenses
(7 Operator (3)
Alantic City License Key | TyKoFSl s b 3w
5y System (1)
9 Line (12) License Type  |SIP Trunk Channels
Control Unit 33
4 Extension (Z5)
& userze)
H ﬂ HuntGroup (1)
@ Short Code (61) Expiry Date | Mever
B Service (0)
ol RAS (1)
=] @ Incoming Call Route {19
Eﬂ anPort {0)
a4 Directory (0)
£179 Time Profile (0
@ Firewall Profile {1}
(- Jill IP Route (4)
@ Account Code (0)
= W License (77}
B 1600 Series Phones
& 3rd Party IP Endpoil
. Advanced Edition
W Advanced Small Cor
B ALDT: Woicemall
. Avaya IP endpoints
& Avaya IP endpoints
. Branch Edition

License Status | Valid

Instances 255

&
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To view the physical hardware comprising the IP Office system, expand the components under
the Control Unit in the Navigation pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital stations ports, two analog extension
ports, 4 analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module
supporting VoIP codecs. An IP Office hardware configuration with a VCM component is
necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices ot IP 500 V2 =
K EOOTR(4) Uik
i Operator (3)
= Atlantic City Device Humber :
= System (1) Uit Type IP 500 ¥2
T Line (14)
=== Conkral Unik {3 Yersion 8.1 (69
o 1IPSOOYE
= 2 COMBOBZ10fATM || Serial Number UM 5
“ir 3 DIGSTASIATMY
it IP Add 10.32.178.25
Ay Extension (25) n s
ﬂ User (27) Interconnect Mumber 1]
ﬁ HunkGroup {173
B Short Code (61) Module Number Conkrol Lnit
@ Service (0}
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5.2. System

Configure the necessary system settings.

5.2.1. System — LAN1 Tab

In the sample configuration, the Avaya IP Office LAN port was used to connect to the enterprise
network. The LANT1 settings correspond to the LAN port on the Avaya IP Office 500 V2. To
access the LAN1 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the IP Office. In the case of the compliance test, the system name is Atlantic
City. Next, navigate to the LAN1 = LAN Settings tab in the Details Pane. Set the IP Address
field to the IP address assigned to the Avaya IP Office LAN port. Set the IP Mask field to the
mask used on the enterprise network. All other parameters should be set according to customer
requirements.

M= u "
IP Offices = Atlantic City
@& BOOTP (4) S\,-'stem. LAML  |Lanz | DMS || voicemail | Telephony | Direckory Services | Swstem Events
[ Operator (3) r = Y srress
=% Atantic City LAN Zethings | yoIP || Metwork Topology | SIF Registrar
=2 System (1) e e ey
10 32 128 25
< Atlantic City lpeela et = |
&9 Line (14) IF Mask 755 . 255 . 255 . 0
-2z Control Unit (3]
[+-48# Extension (25} Primary Trans. IP Address 0 a 0 0
=] 2 User (27) =
[+ ﬂ HurbGroup (1) RIP Mode N':'”E |
[+ @M Short Code (61) [ Enable MAT
@B service (D)
-l RAS (1) Mumber OF DHCP IP Addresses (200 5
[+ @ Incoming Call Route (28} DHEP Made
¥ wanPart (0)
@i Directory (0 ) Server () Client () Dialin  (¥) Disabled
f',"\ Time Profile {0}
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. The RTP Port Number Range can be customized to a specific
range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request
RTP media be sent to a UDP port in the configurable range for calls using LAN1. Avaya IP
Office can also be configured to mark the Differentiated Services Code Point (DSCP) in the IP
Header with specific values to support Quality of Services policies for both signaling and media.
The DSCP field is the value used for media and the SIG DSCP is the value used for signaling.
The specific values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient, appropriate
values will be provided by Voice Carrier. All other parameters should be set according to
customer requirements.

E Atlantic City £ | X | v

System | LAML  |LamMz || DMS || VYoicemail | Telephony | Directory Services | Swstem Events | SMTP || SMDR | Twinning || wCM | CCR || G

LAN Setkings | ¥oIP | Metwork Topology || SIP Registrar

H.323 Gatekesper Enable
SIP Trunks Enable
SIP Reqistrar Enable

RTP Port Mumber Range
|:| H.323 Auto-create Extn
Port Range (Minimum) (19122

4 ¥

H. 323 Auto-create User Port Range (Maximum) (53246

4k

[] H.323 Remote Extn Enable

Enable RTCP Monitoring
On Port: 5005

DiffSerw Settings

4

B8 % | DSCRHex) FC 2| DSCP Mask (Hex) |88 516G DSCP (Hex)

46 L DscP 63 3| DSCPMask 34 5 slaDscp
DHCP Settings
Primary Site Specific Option Murmber (SS0M) 176 s
Secondary Site Specific Option Mumber (S50M) 242 &
WLAN Mok Present w
1100 Voice YLAM Site Specific Option Murnber (S50R) (232 &
1100 Yoice YLAN IDs
RTP keepalives
Scope Disabled w
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. The Avaya SBCE will perform network address translation of SIP traffic
but it is not necessary for IP Office to have any knowledge of this translation. Thus, the
parameter was set to Open Internet.

¢ Set Binding Refresh Time (seconds) to 30. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service

provider.

Set the Public Port to the port Avaya IP Office will listen on.
¢ All other parameters should be set according to customer requirements.

= Atlantic City

Swstem | LAML | LaMN2 | DNS | Voicemail | Telephomy || Direckory Services | Syskemn Evenks | SMTP | SMDR | T
Lar Settings | YoIP | Mebwork Topology | SIP Registrar
Metwork Topology Discowvery
STUM Server IP Address 10 20 165 13 STUM Pork 3478 =
FirewsalliMAT Type Open Internet L
Binding Refresh Time =0 ~
(seconds) ¥
Public IP Address 0 1] 0 0
Public Part s0s0 3 Fun STIUM Zancel
|:| Fun STUM on skartup
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 56
SPOC 9/20/2013 ©2013 Avaya Inc. All Rights Reserved. VCIPO81SBCE62



5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding

and call transfer to the PSTN.

If for security reasons incoming calls should not be allowed to

transfer back to the PSTN then leave this setting checked.

E Atlantic City £ i Al Al

System || LANL | LAMNZ | DNS voicemail | Telephony _Directnry Services | System Events | SMTP | SMDR | Twinning || YCM CCR Codecs
Telephony | Tones & Music | Call Log
Analogue Extensions Companding Law
. Swiktch Line
Default Qutside Call Sequence Taormal |
Default Inside Call Sequence Ring Type 1 v| © U-Law © U-Law Line
Default Ring Back Seguence Ring Tvpe 2 w & oiew ® 5iviihe
Restrict Analogue Extension Ringer Yolkage [
Dial Delay Time {secs) 4 & [] oss status
Dial Delay Count 0 3 . Auka Hald
Default Mo Answer Time (secs) |25 3 Dial By Mame
Hold Timeout {secs) 0 % Shows Account Code
Park Timeout {secs) 300 3- [ 1nhibit CFf-Switch Forward TransFer
Ring Delay (secs) 5 & [] Restrict Metwork Interconnect
Call Priority Promation Time (secs) |Disabled E [] Drop External ©nly Impromptu Conference
Diefault Currency :LISD - [] wisually Differentiate External Call
Default Mame Priority Favo.r Trunk e [ unsupervised Analog Trunk Disconnect Handling
. High Quality Conferencing
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page
(not shown).

Atlantic City

Swskem | LAML || LAMZ | DNS Yoicemail | Telephony | Directory Services || System Events | SMTP | SMDR | Twinning | wCM

[] send ariginal caling party information For Mobile Twinning

Zalling party information For
Mobile Twinning

5.3. IP Route

Navigate to IP Route = 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP Address of the default router for the enterprise
network.

¢ Set Destination to LAN1 from the drop-down list.

Click the OK button at the bottom of the page (not shown).

IP Offices = 0.000 o S 2 S B 2 R S

K BOOTR(4) | 1P Route
i Operator (3)
=p Atlantic Ciky
1557 System (1) TP Mask o 0 0 '
1 Line (14) —_—
v Control Unit (3) Gateway P Address |10 32 125 . 254
|- Extension (25) =
User (27)
HuntiGraup (1) Metric Io
Short Code {61}

R |

B Service (0) [ Prowy ARP
1ol
P

]

]
i

IF Address 0 i} a o

2]

B

=l

Destination LAN1 |

]

2]
43|

]

=)

|

RAS (1)

=)

5

Incoming Call Route (28)
Eﬂ ‘WanPart (0)
@ Directory (0)
£ Time Profile (o)
] @ Fireweall Profils {13
= [l IP Route (4)

EA 0.0.0.0
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5.4.

SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Voice
Carrier IntelliSIP Trunking Service. To create a SIP line, right-click Line in the Navigation
Pane and select New - SIP Line.

5.4.1. SIP Line - SIP Line Tab

On the SIP Line tab in the Details Pane, configure the parameters as shown below.

IP Offices

- R BOOTP (4)

& Cperator (3)
27 Atlantic Ciky
|-y Swskem (1)

[+

Set ITSP Domain Name to the domain provided by Voice Carrier.
Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, IP Office will include the Diversion Header for calls that are directed
via Mobile Twinning out the SIP Line to Voice Carrier. It will also include the Diversion
Header for calls that are call forwarded out the SIP Line.
Check REFER Support.
Check the In Service box. This makes the trunk available to incoming and outgoing calls.
Check the Check OOS box. IP Office will use the SIP OPTIONS method to periodically
check the SIP Line. The time between SIP OPTIONS sent by IP Office will use the
Binding Refresh Time for LAN1, as shown in Section 5.2.1.

Default values may be used for all other parameters.

B SIP Line - Line 22 B - X[ v« |

SgALine (14)

|-z Control Unik {3)
|- Extension (25)
: User (27)

| ﬂ HuntGroup (1)
|- @3 Short Cade (61)

@ Service (0}

Il RS (1)
|- Incoming Call Route (28)

EEI ‘wanPort (09
s Directory (0)
£ Time Profile (0)

1 @ Firewall Profile (13
- [l TP Route (4)

| Account Cade (0)

|- W License (77)

@& Tunnel (0)

1 ﬁ‘, User Rights (3}
| g ARS (Z)

" RAS Location Requast {0)
f» E911 System (1)

SIP Line |Transport || SIP URI||YoIP | T38 Fax| SIP Credentials

Line Mumbey 22 &
ITSP Domain Mame | avayatest, callingcloud.net
Prefix

Mational Prefix 1}

Country Code

International Prefix |00

Send Caller ID Diversion Header v

Association Method | By Source IP address b

REFER. Support

Incoming Auko
Cukgoing Auko
UPDATE Supported | Mewer b

In Service
Use Tel URL
Check 005

Call Routing Method

Originator number For
forwarded and twinning calls

Mame Priority
Caller 1D from From header

Send From In Clear

User-fugent and Server
Headers

Request URI w

Swskem Default W

O
[
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5.4.2. SIP Line - Transport Tab
Select the Transport tab. Set the parameters as shown below.

e Set ITSP Proxy Address to the IP address of the internal signaling interface of the
Avaya SBCE.

¢ Set Layer 4 Protocol to UDP.
¢ Set Use Network Topology Info to the network port used by the SIP line to access the

far-end and configured in Section 5.2.1.
e Set the Send Port to 5060.
Default values may be used for all other parameters.

E SIP Line - Line 22 - X v < |

SIF Line| Transpork |SIF‘ URI|\YoIP | T38 Fax|sIP Credentials
ITSP Proxy Address |10.32.128.20 |
Metwork Configuration
Layer 4 Pratocal [ v|  sendport [s060 ]
IJse Metwork Topology Info |L.ﬁ.N 1 w | | |
Explicit DNS Server(s) | 0 0 0 o || o 0 0 o |
Calls Route via Registrar
Separate Regiskrar |
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5.4.3. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

¢ Set Local URI, Contact, Display Name and PAI to Use Internal Data. This setting
allows calls on this line whose SIP URI matches the number set in the SIP tab of any
User as shown in Section 5.7.

¢ For Registration, select 0: <None> from the pull-down menu.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8. Similarly, associate the line to an outgoing line group
using the Outgoing Group field. The outgoing line group number is used in defining
ARS entries for routing outbound traffic to this line in Section 5.6. For the compliance
test, a new incoming and outgoing group 22 was defined that only contained this line
(line 22).

¢ Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
Ei SIP Line - Line 22* e - X | v |«
SIP Line| Transport| SIP URI [WoIP | T3S Fax| SIP Credentials
Channel  Groups Wia Local URI  Contact | Display Mame | P&l Credential | Max Calls add, ..
Remaove
Edit. ..

Mew Channel

Wia 10,32,128.25
Local URI Ise Internal Data w
Conkact se Internal Data -
Display Mame Ise Internal Data w
PAI se Internal Data -
Reqgistration 0 <Mone= L
Incoming Group Ze
Cukgoing Group 22
Max Calls per Channel 10 -
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Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, Display
Name and PAI fields.

5.4.4. SIP Line - VoIP Tab

Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below.

For Codec Selection, select System Default from the pull-down menu. A list of the
codecs in their current order of preference is shown on the right in the Selected column.
The compliance test used the default codec list. To use a custom list of codecs, select
Custom for Codec Selection. Next, move unwanted codecs from the Selected column to
the Unused column. Lastly, move the codecs up or down the list in the Selected column
to achieve the desired order of preference.

Uncheck the VoIP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to G.711.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

Click the OK button at the bottom of the page (not shown).

] SIP Line - Line 22 ek -9 X v <>

SIF Line| Transport| SIP URI| Y0IP T35 Fax| SIP Credentials

Codec Selection System Default w [ volP Silence Suppression

Re-invite Supported

g2 G711 LA a4k '
C.711 ALAY B4 [] use Offerer's Preferred Codec
5.729(a) 8k C5-ACELP D Codec Lockdown

G5.723.1 6K3 MP-MLG

e ] prACK/100rel Supparted

g

Fax Transport Support G711 b
Call Initiation Timeout () [+ -
DTMF Support RFCZE33 v
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5.5. Short Codes

ARS is used to route outbound traffic to the SIP line. A short code is used to route outbound
traffic to ARS. To create a short code, right-click on Short Code in the Navigation Pane and
select New. On the Short Code tab in the Details Pane, configure the parameters as shown
below.

¢ In the Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Set the Line Group Id to the ARS route to be used which is defined in Section 5.6.

Click the OK button (not shown).

IP Offices

K BoOTR (4)

¢ Operator (3)

[=-%=9 Atlantic City
3y System (1)
9 Line (14)

<2 Contral Uit £3)

Ay Extension (25)
a User (277
ﬂ Hunt@roup {1}

L+ g Short Code (510

@ Service (1)
ol RS (1)

B 9N;: Dial

Short Code
Code an;
Feature Dial w

Telephone Mumber [N
Line Group I0 51: 5P SIF Route ¥
Locale “

Force Account Code [
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”. In the case of the SIP Line to Voice Carrier
documented in these Application Notes, when a user dials *67 plus the number, IP Office will
include the user’s telephone number in the P-Asserted-Identity (PAI) header and will include the
Privacy: Id header. Voice Carrier will allow the call due to the presence of a valid DID in the
PAI header, but will prevent presentation of the caller id to the called PSTN destination.

= “67N;: Dial |
short Cods |
Code *67N; |
Feature |Dial v |

Telephone Mumber |"-"'-"|"-| |

Line Group ID |51: 5P SIP Route v/

Locale | w |

Force Account Code [
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5.6. ARS

ARS is used to route outbound traffic to the SIP line. To define a new ARS route, right-click
ARS in the Navigation pane and select New. In the Details pane that appears, a collection of
matching patterns (similar to short codes) can be entered to route calls as shown below.

For the compliance test, two entries were created. The first entry matches on any 1 + 10 digit
number (1XXXXXXXXXX) and then sends only 10 digits (N) in the SIP INVITE message on
the line group defined in Section 5.4.3 (e.g., line group 22). The second entry matches on any
other number (N) and passes it unaltered to the line group.

To create an entry, click the Add button and enter the following in the pop-up window.

¢ In the Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.5 followed by a semi-colon.

e Set Feature to Dial. This is the action that the short code will perform.

¢ Set Telephone Number to N” @avayatest.callingcloud.net”. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. In the
first entry, N represents the remaining 10 digits after removing the preceding 1. In the
second entry, the value N represents the complete number passed to ARS. The domain
avayatest.callingcloud.net is the service provider domain provided by Voice Carrier.

e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.3. This short code will use this line group when placing the
outbound call.

Click the OK button (not shown).

IP Offices B SP SIP Route e M X v«

#- R BOOTP (4) ARS
[-g Operator (3)
=2y Atlantic City ARS Route Id [ secondary Dial kane
[#-“%p System (1)
B9 Line (14) Route Mame 3F SIF Route
[#-== Control Uit {3}
-4 Extension (25) Dial Delay Time System Defalt (4) 3 [ check User Call Barring
£ i User (27)
[+-55§ HuntGroup (1)
[+ 8% short Code (61)
B Service (0)
ol RAS (1) l
(- Incoming Call Route (28)
9 wanPart (0) Time Profile — OUE OF Hours Route <Mones -
s Directory (0)
f:i"‘- Time Profile {07} l
[ @ Firewall Profile (1)

5Bl 1P Route (4) Code Telephone Number Feature Line Group ID

&m Account Code (09 L, N'@avayatest.calingcloud. net” Lial 2z
[+ % License (77) M; M'@avayatest.calingcloud. net” Diial 22
i i Tunnel.(D) Edit...
[ ﬁ‘, User Rights {8}
= ARS(2)

In Service Qut of Service Route <Mone= L

Remave

«# RAS Location Request (0)
-fx E911 System (1) l
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User = Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.3). The
example below shows the settings for User Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Voice Carrier. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving
this user and a SIP Line should be considered private, then the Anonymous box may be checked
to withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices :

‘S BOOTR (4) User | Vaoicemail | DMD ShortCodes || Source Mumbers | Telephony | Forwarding | Dial In | Woice Recording
i Operator (3)

Extn243: 243

(-39 Atlantic City Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Perd
" System (1) SIP Name 9725551236
T4 Line (14)
“2r Control Unik {3) SIP Display Mame (alias) |[Extnz243
A& Extension (25)
a Conkact 9725551236

ﬁ Huntaroup (1)

@ short Code (61)
B Service (0

o RAS (1)

D Anonymaus
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

5.8.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.

e Set the Line Group Id to the incoming line group of the SIP line defined in Section
5.4.3.

¢ Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

IP Offices E 22 9725551236 g -8 X |

- K BOOTR (4) | standard | yoice Recording | Destinations
{7 Operator (3)
(=527 Atlankic City

(-5 System (1) Bearer Capability j.ﬂn';-' ‘oice ~ |
BT Lime (14) ] .
<= Control Unit {3) Line Group [0 22 |

[+ Extension (25)

Incoming Murmber Q725551236
g User(27)
-4 HuntGroup (1) Incoming Sub Address
(- @ Short Code (610
@ Service (0) Incoming CLI
H-aify RAS (1) Tk T =
+ Incoming Call Route (2&) !
EEI WanPart (0) Pririty [1 - Low v
am Directory (0} - L |
£ Time Profile (0) Tag
[+ Fi Il Profile (1 . T -
= @ rewall Broe (1) Hald Music Source | Swstem Source v |

- J§ll 1P Route (4)
i Account Code (0)

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
9725551236 on line 22 are routed to extension 243.

=
22 9725551236 B - X v«

Standard | Yoice Recording | Destinations

TimePraofile Destination Fallback. Extension
L Default Walue 243 Extrnz43 v v
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Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in
Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

3

Save Configuration
IP Office Settings

Atlankic Ciky

Configuration Reboot Mode
@ Merge

) Immediate

) When Free

) Timed

Reboat Tirme

Call Barring

[ )

[ a4 H Zancel H Help l
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE. It is assumed that the initial
installation of the Avaya SBCE has been completed including the assignment of a management
IP address. The management interface must be provisioned on a different subnet than either the
Avaya SBCE private or public network interfaces (e.g., Al and B1). If the management
interface has not been configured on a separate subnet, then contact your Avaya representative
for guidance in correcting the configuration.

On all screens described in this section, it is to be assumed that parameters are left at their default
values unless specified otherwise.

6.1. Access the Management Interface

Use a web browser to access the web interface by entering the URL https://<ip-addr>, where
<ip-addr> is the management IP address assigned during installation. The Avaya SBCE login
page will appear as shown below. Log in with appropriate credentials.

AVAYA =

Password:

SeSSion Border Contro”er Thiz =ystem is restricted =olely to authorized users for legitimate
= buzinezs purpozesz only. The actual or attempted unauthorized access,
fDl' Ente rp rlse uze or modificationz of thiz system iz strictly prohibited. Unauthorized

uzers are =ubject to company dizciplinary procedures and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The usze of thiz =zystem may be monitored and recorded for
administrative and security reasons. Anyoene accessing this system
exprezsly consents to =uch monitoring and recording, and is advised
that if t reveals possible evidence of criminal activity, the evidence of
zuch activity may be provided to law enforcement officials.

All users must comply with all corpeorate instructions regarding the
protection of infermation assets.

© 2011 - 2013 Avavya Inc. All rights rezerved.
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After logging in, the Dashboard screen will appear as shown below. All configuration screens of
the Avaya SBCE are accessed by navigating the menu tree in the left pane.

Session Border Controller for Enterprise AVAYA
d Dashboard

Aomiistration
Backup/Restore System Time 02:41:48 PM EDT Refiesh  EMS

System Management

> Global Parameters EEET 6.2.0.036 wnj-sbce2

> Global Profiles Build Date Thu Feb 14 23:25:50 UTC 2013

> SIP Cluster

. Domain Polcies
Mone found. Mone found.

> TLS Management

> Device Specific Settings o

Mo notes found.
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6.2. Verify Network Configuration and Enable Interfaces

To view the network information provided during installation, navigate to System Management.
In the right pane, click View highlighted below.

>

>

>

3

3

B

Dashboard
Administration
Backup/Restaore

System Management

Global Parameters
Global Profiles

SIP Cluster

Domain Policies

TLS Management
Device Specific Settings

Session Border Controller for Enterprise AVAYA

System Management

Devices || Updates H SSL VPN || Licensing ‘

Device Mame  Management
|

(Serial Number) Version Status

?rlycssncr?mes;- 10.32.101.20 6.2.0.Q36 Commissioned Reboot Shutdown Restartf-n.ppllcat\ancln Delete

A System Information page will appear showing the information provided during installation. In
the Appliance Name field is the name of the device (vnj-sbce2). This name will be referenced
in other configuration screens. Interfaces Al and B1 represent the private and public interfaces
of the Avaya SBCE. Each of these interfaces must be enabled after installation.

System Information: vnj-sbce?2 X

Appliance Name
Box Type

Deployment Mode

r General Configuration Device Configuration
vnj-shce? HA Mode Mo
SIP Two Bypass Mode Mo
Proxy

10.32.128.20

192.168.96.233

r Network Configuration

Public IP MNetmask Gateway Interface
10.32.128.20 255255 255.0 10.32.128.254 Al
192.168.96.233 255255 255 224 192.168.96.254 B1

r DNS Configuration

Management IP(s)
Primary DNS 10.32.125.200 IP 10.32.101.20
Secondary DNS
DNS Location DMz
DHS Client IP 10.32.128.20
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To enable the interfaces, first navigate to Device Specific Settings > Network Management in
the left pane and select the device being managed in the center pane. In the right pane, click on
the Interface Configuration tab. Verify the Administrative Status is Enabled for both the A1
and B1 interfaces. If not, click Toggle to enable the interface.

Dashboard
Administration

~

Session Border Controller for Enterprise AVAYA

Network Management: vnj-sbce2

Backup/Restore ; !
Network Configuration | | Interface Configuration |
System Management 1 |
> Global Parameters vnj-sbee? Administrative Status
> Global Profiles Al Enabled Toggle
+ SIP Cluster A2 Disabled Toggle
> Domain Paolicies
B1 Enabled Toggle
> TLS Management
4 Device Specific Settings
Network
Management
Media Interface
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6.3. Signaling Interface

A signaling interface defines an IP address, protocols and listen ports that the Avaya SBCE can
use for signaling. Create a signaling interface for both the internal and external sides of the

Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Signaling Interface in the
left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the
right pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Sig_Intf was created for the Avaya SBCE
internal interface. When configuring the interface, configure the parameters as follows:

e Set Name to a descriptive name.
o Set the Signaling IP to the IP address associated with the private interface (A1) defined in

Section 6.2.

¢ In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for SIP requests from Avaya IP Office for each transport protocol. For the compliance
test, the UDP Port was set to 5060.

Signaling interface Ext_Sig_Intf was created for the Avaya SBCE external interface. When
configuring the interface, configure the parameters as follows:

e Set Name to a descriptive name.
o Set the Signaling IP to the IP address associated with the public interface (B1) defined in

Section 6.2.

¢ In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for SIP requests from the service provider for each transport protocol. For the
compliance test, both UDP and TCP were tested with Voice Carrier. Thus, the UDP Port
and TCP Port were set to 5060.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

> Domain Policies

> TLS Management

4 Device Specific Settings
Network Management
Media Interface

Signaling Interface

Session Border Controller for Enterprise

Signaling Interface: vnj-shce2

Devices Signaling Interface

AVAYA

vnj-sbce?

Signaling IP

Int_Sig_lntf 10.32.128.20

Ext_Sig_Intf 192.168.96.233

uop
Port

5060 —
5060 —

TLS Profile

None

None

Add

Edit Delete

Edit Delete
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6.4. Media Interface

A media interface defines an IP address and port range for transmitting media. Create a media
interface for both the internal and external sides of the Avaya SBCE.

To create a new interface, navigate to Device Specific Settings - Media Interface in the left
pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the right
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Media_Intf was created for the Avaya SBCE
internal interface. When configuring the interface, configure the parameters as follows:

e Set Name to a descriptive name.

e Set the Media IP to the IP address associated with the private interface (A1) defined in
Section 6.2.

¢ Set Port Range to a range of ports acceptable to both the Avaya SBCE and Avaya IP
Office. For the compliance test, the port range used was selected arbitrarily.

Signaling interface Ext_Media_Intf was created for the Avaya SBCE external interface. When
configuring the interface, configure the parameters as follows:

e Set Name to a descriptive name.

e Set the Media IP to the IP address associated with the public interface (B1) defined in
Section 6.2.

¢ Set Port Range to a range of ports acceptable to both the Avaya SBCE and the service
provider. For the compliance test, the port range used was selected arbitrarily.

Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: vnj-sbce2

Administration

Backup/Restore —‘Media P

System Management
vnj-shce2

» Global Parameters Modifying or deleting an existing media interface will require an application restart before taking
> Global Profiles effect. Application restarts can be issued from System Management.
> SIP Cluster Add
> Domain Policies
Name Media IP Port Range
> TLS Management e = EEL AR
] . ’ Int_Media_Intf 10.32.128.20 35000 - 40000 Edit Delete
4 Device Specific Settings
Network Management Ext_Media_Intf 192.168.96.233 35000 - 40000 Edit Delste
Media Interface
Signaling Interface
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 30 of 56

SPOC 9/20/2013 ©2013 Avaya Inc. All Rights Reserved. VCIPO81SBCE62



6.5. Server Interworking

A server interworking profile defines a set of parameters that aid in interworking between the
Avaya SBCE and a connected server. Create a server interworking profile for Avaya IP Office
and the service provider SIP server. These profiles will be applied to the appropriate server in
Section 6.7.1 and 6.7.2.

To create a new profile, navigate to Global Profiles = Server Interworking in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed. To view the settings of an existing profile, select the profile from the center pane.
The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard ~|  Interworking Profiles: ¢s2100
Administration Add
Backup/Restore
Ee:

Systern Management It is not recommended to edit the defaults. Try cloning or adding a new profile instead
> Global Parameters cs2100 General ‘ | Timers ‘ | URI Manipulation | | Header Manipulation | | Advanced |
4 Global Profiles F i ~

bl Proes

B et 0CS-Edge-Ser. Hold Support RFC3264

Server ] T, 180 Handling MNone

Interwerking e 181 Handling None

Phaone Interworking 182 Handling e

Media Forking QOCS-FrontEnd... .

Routing 183 Handling MNone

Server Configuration 2 Refer Handling No b
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6.5.1. Server Interworking — Avaya IP Office

For the compliance test, server interworking profile IPOffice was created for Avaya IP Office by
creating a new profile and accepting the default values for all settings. The General tab

parameters are shown below.

General ‘ | Timers | ‘ URI Manipulation ‘ | Header Manipulation ‘ | Advanced |

Privacy Enabled

User Name

Privacy Header

DTMF Support

P-Asserted-ldentity

P-Preferred-ldentity

General

Hold Support NOME
150 Handling Mone
181 Handling Mone
182 Handling MNone
183 Handling Mone
Refer Handling Mo
3xx Handling Mo
Diversion Header Support Mo
Delayed SDP Handling MNo
T.38 Support Mo
LRI Scheme SIP
ia Header Format RFC3261

DTMF

Mone

Edit

The Timers, URI Manipulation, Header Manipulation tabs have no entries.

CTM; Reviewed:
SPOC 9/20/2013

Solution & Interoperability Test Lab Application Notes

©2013 Avaya Inc. All Rights Reserved.

&)

v
32 of 56
VCIPO81SBCE62



The Advanced tab parameters are shown below.

General ‘ ‘ Timers ‘ ‘ URI Manipulation ‘ ‘ Header Manipulation Advanced

Record Routes Both
Topology Hiding: Change Call-D Yes
Call-Infa MNAT Mo

Change Max Forwards Yes

Include End Point IP for Context Lookup Mo

OCS Extensions Mo
AVAYA Extensions Mo
MORTEL Extensions Mo
Diversion Manipulation Mo
Metaswitch Extensions No
Reset on Talk Spurt Mo

Reset SRTP Context on Session Refresh Mo

Has Remote SBEC Yes
Route Response on Via Port Mo
Cisco Extensions Mo

6.5.2. Server Interworking — Voice Carrier

For the compliance test, server interworking profile SP-General was created for the Voice
Carrier SIP server. When creating the profile, the default values were used for all parameters.
Thus, the SP-General profile is identical to the IPOffice profile created in Section 6.5.1.

6.6. Signaling Manipulation

Signaling manipulation scripts provides for the manipulation of SIP messages which cannot be
done by other configuration within the Avaya SBCE. It was not necessary to create any
signaling manipulation scripts for interoperability with Voice Carrier.
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6.7. Server Configuration

A server configuration profile defines the attributes of the physical server. Create a server
configuration profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Server Configuration in the left pane.
In the center pane, select Add. A pop-up window (not shown) will appear requesting the name
of the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. To view the settings of
an existing profile, select the profile from the center pane. The settings will appear in the right
pane.

Session Border Controller for Enterprise AVAYA

Dashboard Server Configuration

Administration Add

Backup/Restore

Server Profiles )
System Management ) Use the add button to create a new Server Configuration profile.
> Global Parameters Mo entries

found.

4 Global Profiles

Domain DoS

Fingerprint

Server Interworking

Phone Interworking

Media Forking

Routi

Topology Hiding
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6.7.1. Server Configuration — Avaya IP Office

For the compliance test, server configuration profile IPO-A City was created for Avaya IP
Office. When creating the profile, configure the General tab parameters as follows:

Set Server Type to Call Server.

Set IP Addresses / FQDN:s to the IP address of the Avaya IP Office signaling interface.

Set Supported Transports to the transport protocol used for SIP signaling between Avaya
IP Office and the Avaya SBCE.

Set the UDP Port to the port Avaya IP Office will listen on for SIP requests from the Avaya
SBCE.

[ Rename H Clone H Delete l

General | | Authentication Heartbeat | | Advanced

Server Type Call Server
IP Addresses / FQDMNs 10.32.128.25
Supported Transports LDP

LIDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Avaya
IP Office defined in Section 6.5.1.

[ Rename ][ Clone ][ Delete ]

General | | Authentication Heartheat éﬂ«duancedé

Enable DoS Protection ]
Enable Grooming [F]
Interworking Profile IPOffice
Signaling Manipulation Script Mone
UDP Connection Type SUBID

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 35 of 56
SPOC 9/20/2013 ©2013 Avaya Inc. All Rights Reserved. VCIPO81SBCE62



6.7.2. Server Configuration — Voice Carrier

For the compliance test, server configuration profile VoiceCarrier was created for Voice
Carrier. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Trunk Server.

e Set IP Addresses / FQDNSs to the IP address of the Voice Carrier SIP server.

e Set Supported Transports to the transport protocol used for SIP signaling between Voice
Carrier and the Avaya SBCE. In the compliance test, both UDP and TCP were tested.

¢ Set the UDP Port or TCP Port, whichever applies, to the standard SIP port of 5060. This is
the port Voice Carrier will listen on for SIP requests from the Avaya SBCE. The example
below shows the use of UDP.

[ Rename ][ Clone ][ Delete ]

General || Authentication ‘ | Heartbeat | | Advanced |

Server Type Trunk Server

IP Addresses / FQDNs 192.168.243.180
Supported Transports UDP

UDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Voice
Carrier defined in Section 6.5.2.

[ Hename H Clone H Delete ]
General || Authentication H Heartbheat Advanced
Enable DoS Protection L
Enable Grooming ¥
Interwarking Profile SP-General
Signaling Manipulation Script Mone
TCP Connection Type SUBID
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6.8. Application Rules

An application rule defines the allowable SIP applications and associated parameters. An
application rule is one component of the larger endpoint policy group defined in Section 6.11.
For the compliance test, the predefined default-trunk application rule (shown below) was used
for both Avaya IP Office and the Voice Carrier SIP server.

To view an existing rule, navigate to Domain Policies = Application Rules in the left pane. In
the center pane, select the rule (e.g., default-trunk) to be viewed.

» Global Parameters

» Global Profiles

> SIP Cluster

4 Domain Palicies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules
End Point Policy

default

default-trunk

Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: default-trunk

Administration Add [Filter By Device... [h
Backup/Restore

System Management It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

Application Rule

Maximum Concurrent  Maximum Sessions

FRITER I T oL Sessions Per Endpoint
Voice 2000 2000
Video O O
M o o

Miscellaneous

COR Support Mone

RTCF Keep-Alive Mo
Groups
Session Policies
> TLS Management
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6.9. Media Rules

A media rule defines the processing to be applied to the selected media. A media rule is one
component of the larger endpoint policy group defined in Section 6.11. For the compliance test,
the predefined default-low-med media rule (shown below) was used for both Avaya IP Office
and the Voice Carrier SIP server.

To view an existing rule, navigate to Domain Policies > Media Rules in the left pane. In the
center pane, select the rule (e.g., default-low-med) to be viewed.

Each of the tabs of the default-low-med media rule containing data is shown below.

The Media NAT tab has no entries.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: default-low-med
Administration Add | |Filter By Devics.. v
Backup/Restore .
Media Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.
System Management
default-low-med
» Global Parameters Media NAT ‘ | Media Encryption ‘ | Media Anomaly | | Media Silencing ‘ | Media QoS |
> Global Profiles default-low-med-enc
» SIP Cluster default-high Media NAT Learn Media IP dynamically
4 Domain Policies
o default-high-enc
Application Rules

Border Rules avaya-low-med-enc

e

The Media Encryption tab indicates that no encryption was used.

Media NAT | | Media Encryption | Media Anomaly | | Media Silencing | | Media QoS |

Audio Encryption
Preferred Formats RTP

Interworking

Preferred Formats RTP

Interworking

Miscellaneous

Capability Megatiation O
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The Media Anomaly tab shows Media Anomaly Detection was enabled.

Media NAT | | Media Encryption Media Anomaly Media Silencing ‘ ‘ Media Qo5

Media Anomaly Detection

Detect RTP Injection Attack
Asymmetric RTP O
Action Alert

The Media Silencing tab has no entries.

The Media QoS settings are shown below.

Media NAT | | Media Encryption | | Media Anomaly | | Media Silencing Media QoS

Media QoS Reporting

RTCP Enabled [l

Media QoS Marking

Enabled
QoS Type DSCP
Audio Qo5
Audio DSCP EF
Video QoS
Video DSCP EF

39 of 56
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6.10. Signaling Rules

A signaling rule defines the processing to be applied to the selected signaling traffic. A signaling
rule is one component of the larger endpoint policy group defined in Section 6.11. For the
compliance test, the predefined default signaling rule (shown below) was used for both Avaya
IP Office and the Voice Carrier SIP server.

To view an existing rule, navigate to Domain Policies = Signaling Rules in the left pane. In
the center pane, select the rule (e.g., default) to be viewed.

The General tab settings are shown below.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: default
Administration Add [Filter By Device... v
Backup/Restare
Signaling Rules s e ended to e e defaults. i i & e instead.
System Management It is not recommended to edit the defaults. Try cloning or adding a new rule instead
default
» Global Parameters General | Requests H Responses | Request Head || Resp Head || Signaling QoS ‘
> Global Profiles No-Content-Typ... -~
> SIP Cluster
R it All
4 Domain Policies Fuests o
Application Rules Nen-2XX Final Responses Allow
Border Rules Optional Request Headers Allow
Media Rules Optional Response Headers Allow
Security Rules
Time of Day Rules Requests Allow
End Point Policy Non-2XX Final Responses Allow
Groups
Session Palicies Optional Request Headers Allow
> TLS Management Optional Response Headers Allow
> Device Specific Settings
Content-Type Policy
Enable Content-Type Checks )
Action Allow Multipart Action Allow
e

The Requests, Responses, Request Headers, and Response Headers tabs have no entries. The
Signaling QoS tab is shown below.

General ‘ | Requests ‘ | Responses || Request Headers ‘ | Response Headers Signaling QoS
Signaling QoS
QoS Type DSCP
DSCP AF41
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6.11. Endpoint Policy Groups

An endpoint policy group is a set of policies that will be applied to traffic between the Avaya
SBCE and a signaling endpoint (connected server). Thus, an endpoint policy group must be
created for Avaya IP Office and the service provider SIP server. The endpoint policy group is
applied to the traffic as part of the endpoint flow defined in Section 6.14.

To create a new group, navigate to Domain Policies - End Point Policy Groups in the left
pane. In the center pane, select Add. A pop-up window (not shown) will appear requesting the
name of the new group, followed by series of pop-up windows in which the group parameters
can be configured. Once complete, the settings are shown in the far right pane. To view the
settings of an existing group, select the group from the center pane. The settings will appear in
the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: default-low
Administration Add [Filter By Device.. v
Backup/Restare
Policy Groups is e ende edit the defaults. e instead.
Systern Management It is not recommended to edit the defaults. Try adding a new group instead
Global P default-low ) __
> Global Profiles default-low-enc
Policy Group
> SIP Cluster default-med
4 Domain Policies Summa Add
. default-med-enc
Application Rules Order  Application Border Media Security Signaling  Time of Day
Border Rules default-high defauldow
. -I default default 7 default-low  default default Edit Clone
Media Rules default-high-enc -med
Security Rules

QCS-default-high
Signaling Rules

Time of Day Rules avaya-deflow-e...
End Point Policy

Groups

6.11.1. Endpoint Policy Group — Avaya IP Office

For the compliance test, endpoint policy group IPO-EP-Policy was created for Avaya IP Office.
Default values were used for each of the rules which comprise the group with the exception of
Application. For Application, enter the application rule created in Section 6.8. The details of
the default settings for Media and Signaling are showed in Section 6.9 and Section 6.10
respectively.

Policy Group

Summary H Add l

Order  Application Border Media Security Signaling  Time of Day

default- default-low N .
trunk default ‘med default-low  default default Edit Clone
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6.11.2. Endpoint Policy Group — Voice Carrier

For the compliance test, endpoint policy group SP-EP-Policy was created for the Voice Carrier
SIP server. Default values were used for each of the rules which comprise the group with the
exception of Application. For Application, enter the application rule created in Section 6.8.
Thus, the SP-EP-Policy is identical to the IPO-EP-Policy created in Section 6.11.1.

6.12. Routing

A routing profile defines where traffic will be directed based on the contents of the URL. A
routing profile is applied only after the traffic has matched an endpoint server flow defined in
Section 6.14. Create a routing profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Routing in the left pane. In the center
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
profile, followed by series of pop-up windows in which the profile parameters can be configured.
Once complete, the settings are shown in the far right pane. To view the settings of an existing
profile, select the profile from the center pane. The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: default
Administration Add
Backup/Restore
> Global Parameters default Routing Profile
4 Global Profiles

Domain DoS

Fingerprint Priority URI Group Mext Hop Server 1 Mext Hop Server 2

Server Interworking N View  Edit

Phone Interwarking
Media Forking

9
Server Configuration
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6.12.1. Routing — Avaya IP Office

For the compliance test, routing profile To-IPO-ACity was created for Avaya IP Office. When
creating the profile, configure the parameters as follows:

Set the URI Group to the wild card * to match on any URIL

Set the Next Hop Server 1 field to the IP address of Avaya IP Office signaling interface.
Enable Next Hop Priority.

Set the Outgoing Transport field to UDP.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 10.32.128.25

Mext Hop Senver 2

MNext Hop Priority
MNAPTR Fi
SRV O
Mext Hop in Dialog d
Ignore Route Header F
Cutgoing Transport UDP
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6.12.2. Routing — Voice Carrier

For the compliance test, routing profile To-Trunks was created for Voice Carrier. When
creating the profile, configure the parameters as follows:

Set the URI Group to the wild card * to match on any URL

Set the Next Hop Server 1 field to the IP address of the Voice Carrier SIP server.
Enable Next Hop Priority.

Set the Outgoing Transport field to UDP or TCP as defined by Voice Carrier.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 192 168 243180

Mext Hop Server 2

Next Hop Priority
MAPTR Fi
SRV O
Mext Hop in Dialog i
lgnore Route Header ]
Outgoing Transport UDp
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6.13. Topology Hiding

Topology hiding allows the host part of some SIP message headers to be modified in order to
prevent private network information from being propagated to the untrusted public network. It
can also be used as an interoperability tool to adapt the host portion of these same headers to
meet the requirements of the connected servers. The topology hiding profile is applied as part of
the endpoint flow in Section 6.14. For the compliance test, the predefined default topology
hiding profile (shown below) was used for both Avaya IP Office and the Voice Carrier SIP

SErver.

To add a new profile or view an existing profile, navigate to Global Profiles > Topology
Hiding in the left pane. In the center pane, select Add to add a new profile. In the center pane,

select an existing profile (e.g., default) to be viewed.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

4 (Global Profiles
Domain DoS
Fingerprint
Server Interworking
Phone Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

Topology Hiding Profiles: default
Add

Session Border Controller for Enterprise

AVAYA

Clone

Topology Hiding It is not recommended to edit the defaults. Try cloning or adding a new profile instead.
Profiles

default Topology Hiding

cisco_th_profile Header
SDP

From
Request-Line
To
Record-Route

Via

Criteria
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action

Auto
Auto
Auto
Auto
Auto

Auto

Overwrite Value
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6.14. End Point Flows

Endpoint flows are used to determine the signaling endpoints involved in a call in order to apply
the appropriate policies. When a packet arrives at the Avaya SBCE, the content of the packet (IP
addresses, URISs, etc) is used to determine which flow it matches. Once the flow is determined,
the flow points to policies and profiles which control processing, privileges, authentication,
routing, etc. Once routing is applied and the destination endpoint is determined, the policies for
the destination endpoint are applied. Thus, two flows are involved in every call: the source
endpoint flow and the destination endpoint flow. In the case of the compliance test, the signaling
endpoints are Avaya IP Office and the service provider SIP server.

To create a new flow for a server endpoint, navigate to Device Specific Settings = End Point
Flows in the left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be
managed. In the right pane, select the Server Flows tab and click the Add button. A pop-up
window (not shown) will appear requesting the name of the new flow and the flow parameters.
Once complete, the settings are shown in the far right pane.

Session Border Controller for Enterprise AVAYA

Dashboard End Point Flows: vnj-sbce2
Administration

Backup/Restore ; |
Subscriber Flows | | Server Flows |
System Management . :

vnj-shce2

> Global Parameters Add

> Global Profiles
. SIP Cluster Use the add button to create a new Server Flow.

> Domain Policies

> TLS Management

4 Device Specific Settings
Metwork Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows

Session Flows
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6.14.1. End Point Flow — Avaya IP Office

For the compliance test, endpoint flow IPO-ACity was created for Avaya IP Office. All traffic
from Avaya IP Office will match this flow as the source flow and use the specified Routing
Profile To-Trunks to determine the destination server and corresponding destination flow. The
End Point Policy and Topology Hiding Profile will be applied as appropriate. When creating
the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Avaya IP Office server created in Section 6.7.1.
To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the external signaling interface.

Set the Signaling Interface to the internal signaling interface.

Set the Media Interface to the internal media interface.

Set the End Point Policy Group to the endpoint policy group defined for Avaya IP
Office in Section 6.11.1.

Set the Routing Profile to the routing profile defined in Section 6.12.2 used to direct
traffic to the Voice Carrier SIP server.

Set the Topology Hiding Profile to the topology hiding profile defined for Avaya IP
Office in Section 6.13.

View Flow: IPO-ACity X

r Criteria r Profile
Flow Mame IPO-ACity Signaling Interface Int_Sig_Intf
Server Configuration  IPO-ACity Media Interface Int_Media_Intf
URI Group * End Point Policy Group  IPO-EP-Policy
Transport * Routing Profile To-Trunks
Remote Subnet * Topology Hiding Profile  default
Received Interface Ext Sig_Intf File Transfer Profile MNone
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6.14.2. End Point Flow — Voice Carrier

For the compliance test, endpoint flow VoiceCarrier was created for the Voice Carrier SIP
server. All traffic from Voice Carrier will match this flow as the source flow and use the
specified Routing Profile To-IPO-ACity to determine the destination server and corresponding
destination flow. The End Point Policy and Topology Hiding Profile will be applied as
appropriate. When creating the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Voice Carrier SIP server created in Section 6.7.2.

To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the internal signaling interface.

Set the Signaling Interface to the external signaling interface.

Set the Media Interface to the external media interface.

Set the End Point Policy Group to the endpoint policy group defined for Voice Carrier

in Section 6.11.2.

¢ Set the Routing Profile to the routing profile defined in Section 6.12.1 used to direct
traffic to Avaya IP Office.

e Set the Topology Hiding Profile to the topology hiding profile defined for Voice Carrier

in Section 6.13.

View Flow: VoiceCarrier

r Criteria r Profile
Flow Mame VoiceCarrier Signaling Interface Ext Sig Intf
Server Configuration  VoiceCarrier Media Interface Ext Media_Intf
URI Group * End Point Policy Group  SP-EP-Paolicy
Transport * Routing Profile To-IPO-ACity
Remote Subnet * Topology Hiding Profile  default
Received Interface Int_Sig_Intf File Transfer Profile MNone
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7. Voice Carrier IntelliSIP Trunking Configuration

Voice Carrier is responsible for the configuration of the Voice Carrier IntelliSIP Trunking
Service. The customer will need to provide the IP address used to reach the enterprise. In the
case of the compliance test, this is the Avaya SBCE public address. Voice Carrier will provide
the customer the necessary information to configure Avaya IP Office and Avaya SBCE at the
enterprise including:

Voice Carrier SIP domain

IP address of the Voice Carrier SIP proxy
Supported codecs

DID numbers

8. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

8.1. System Status

The System Status application is used to monitor and troubleshoot IP Office. Use the System
Status application to verify the state of the SIP trunk. System Status can be accessed from Start
-> Programs - IP Office = System Status.

The following screen shows an example Logon screen. Enter the IP Office IP address in the
Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

M3 1P Office RB.1 System Status

AVAYA IP Office System Status

Help Exit About

Online | offline

Logon

Control Unit IP Address: [plickabiye)

Services Base TCP Port: FEDHES

MBIV T EE Adninistrator

Password: ............Ol

M Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State for each channel. If no active call is currently in session (as shown below), the
state should be Idle. If some channels are taken by active calls, then the Current Sate will be
shown as Connected.

IP Office System Status

About

Alarms

SIP Trunk Summary

Lines:1-4 Peer Domain Marnme: avayatest.calingcloud.net
LB Resolved Address: 192.168.243.180
II:::E :; Line Murnber: 22
Line: 19 Mumber of Administered Channels: 10
Line: 20 Mumber of Channels in Use: i}
Line: 21 Adminiskered Compression: G711 Mu, G711 A, G729 4, Q7231
Silence Suppression: Off
SIP Trunk Channel Licenses: Unlirnited . 0%
SIP Trunk Channel Licenses in Use: a
SIF Device Features: REFEF. {Incoming and Cukgoing)
Direcki,,, Round
Trip On,
1 Ide |21:39... ~
2 Idle  |21:46...
3 Ide |1 day...
4 Idle [1day...

Alarms

alarms for Line: 22 SIP avayatest.callingcloud.het

Occurrences Error Descripkion
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8.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor. The application allows the
monitored information to be customized. To customize, select Filters 2 Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked.

A |
T1 | VPN | WiaN | SCN

ATM | cal | DTE | EConf | FrameRely | GOD | H222 | Inteface |
1SON ] Kep/Lamp I Directary ] Media ] FPP 1 R2 ] F\nuting] Services  SIP I S_ustem]

Events

¥ Sip [High - [~ STUN
Packets
[ SIP Reg/Opt A= [ SIP Misc Rx
[~ SIP Reg/Opt T [ SIP Misc Tx
[~ SIPCallRx [~ Cm Motify Rix
[~ SIPCall Tx [ Crn Motify Tx
¥ Sip Rz [~ hex IF Filter [nnn.ann. ann. ann)

v SipTx [~ hex

Default All | Clear Al | TabClear&ll| Tabsetal ok | Concel |

Save File | Load File | Select File |

9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 8.1 to
the Voice Carrier IntelliSIP Trunking Service. The Voice Carrier IntelliSIP Trunking Service is
a SIP-based Voice over IP solution for customers ranging from small businesses to large
enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony
trunks. The Voice Carrier IntelliSIP Trunking Service passed compliance testing. Please refer to
Section 2.2 for any exceptions.
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10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] IP Office 8.1 IP500/IP500 V2 Installation, Document Number 15-601042, Issue 27m, July 2,

2013.
[2] IP Office Release 8.1Manager 10.1, Document Number 15-601011, Issue 29u, April 5, 2013.
[3] IP Office System Status Application, Document Number 15-601758, Issue 07a, November

26, 2012.
[4] IP Office Release 8.1 Administering Voicemail Pro, Document Number 15-601063, Issue 8b,

December 11, 2012.
[5] IP Office System Monitor, Document Number 15-601019, Issue 03¢, March 1, 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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11. Appendix A: SIP Line Template

Avaya IP Office supports a SIP Line Template (in xml format) that can be created from an
existing configuration and imported into a new installation to simplify configuration procedures
as well as to reduce potential configuration errors.

Note that not all of the configuration information, particularly items relevant to a specific
installation environment, is included in the SIP Line Template. Therefore, it is critical that the
SIP Line configuration be verified/updated after a template has been imported and additional
configuration be supplemented using Section 5.4 in these Application Notes as a reference.

The SIP Line Template created from the configuration as documented in these Application Notes
is as follows:

<?xml version="1.0" encoding="utf-8"7?>

<Template xmlns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20130816</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>Voice Carrier</DescriptiveName>
<ITSPDomainName>avayatest.callingcloud.net</ITSPDomainName>
<SendCallerID>CallerIDDIV</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>2</ReferSupportIncoming>
<ReferSupportOutgoing>2</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired>
<UseTelURI>false</UseTelURI>
<Check00S>true</Check00S>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority>SystemDefault</LineNamePriority>
<UpdateSupport>UpdateNever</UpdateSupport>
<UserAgentServerHeader />
<CallerIDfromFromheader>false</CallerIDfromFromheader>
<PerformUserLevelPrivacy>false</PerformUserLevelPrivacy>
<ITSPProxy>10.32.128.20</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>AUTOSELECT</CompressionMode>
<UseAdvVoiceCodecPrefs>false</UseAdvVoiceCodecPrefs>
<CallInitiationTimeout>4</CallInitiationTimeout>
<DTMF Support>DTMF_SUPPORT_RFC2833</DTMF Support>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_G711</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
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<CodecLockdown>false</CodecLockdown>
<Rell00Supported>false</Rell00Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

</Template>

To import the above template into a new installation:

1. On the PC where IP Office Manager was installed, copy and paste the above template
into a text document named US_VoiceCarrier_SIPTrunk.xml. Move the .xml file to
the IP Office Manager template directory (C:\Program Files\Avaya\IP
Office\Manager\Templates). It may be necessary to create this directory.

2. Import the template into an IP Office installation by creating a new SIP Line as shown in
the screenshot below. In the Navigation Pane on the left, right-click on Line then
navigate to New = New SIP Trunk From Template:

IP Offices E Analogue Trunk -Line 1
w ‘5 TR Line Settings |Analogue Options
H-¢# Operator (3) L d
(=529 Atlantic CiF=
S Syste [ ew v ] H323 Line
‘+'_‘1| 35 Bt ]| Generate Analogue Trunk Template IPDECT Line
[#-<2 Contr :
[ Exten Of  Copy Settings From Template SIP Line
[# L 1 SIP DECT Line
= = el & cut Chrl+
o 'ﬂ bl d Mew SIP Trunk From Ternplate
@ Short (53 Copy ChrlHC
@ SErvic 1
ol RAS(]
o e Incom 75 Delete Chrl+Del
EB) wanPq o validate
am Direct
£ Time: A
] @ Firewa Mew From Template (Binary)
= T
- il 1P Route (4) ] Line Appearance ID o1
S Orconnt Code (0% L

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 54 of 56
SPOC 9/20/2013 ©2013 Avaya Inc. All Rights Reserved. VCIPO81SBCE62



3. Verify that United States is automatically populated for Country and VoiceCarrier is
automatically populated for Service Provider in the resulting Template Type Selection
screen as shown below. Click Create new SIP Trunk to finish the importing process.

CTM; Reviewed:
SPOC 9/20/2013
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